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1 
Introduction

Design Animation is a tool for creating animation sequences using
Pro/ENGINEER® parts, assemblies, and mechanisms previously created in
Mechanism Design.

Read the following topics for an introduction to Design Animation and
information on how to get started:

Topic Page

Introducing Design Animation............................................................................ 1-2

Accessing Design Animation ............................................................................... 1-3

Learning Design Animation Basics..................................................................... 1-3

Limitations ........................................................................................................... 1-8
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Introducing Design Animation
The Design Animation module enables you to animate mechanisms
previously created in Mechanism Design or any assembly from
Pro/ENGINEER®.  It differs from Pro/MECHANICA MOTION™ and
Mechanism Design in that you can create animation sequences by linking a
series of "snapshots", without being required to create joints or servo motors.

Design Animation is meant for both casual and expert CAD or
Pro/ENGINEER users.  Any designer or engineer can use Design Animation
to:

•  generate high-quality animations for sales and marketing presentations,
management meetings, or design reviews

•  animate assembly, disassembly, and maintenance sequences

•  create complex, composite animations
The components of an animation can be controlled through the Design
Animation timeline.  The timeline appears below the Pro/ENGINEER
graphics window.  You can display, edit, move, and synchronize the
components of the animation on the timeline.

Design Animation enables you to define key frame sequences, describing the
position and orientation of parts and assemblies at specific times during the
animation.  Design Animation interpolates between the frames in the
sequence to produce a smooth animation.  You can include a sequence of key
frames in an animation multiple times.

You can also control animation sequences by identifying key events during
the animation to trigger subanimations (copies of animations inserted into
the timeline) or other effects such as view orientation, transparency, and
magnification.  These view changes enable you to emphasize the most
important aspects of your animation by focusing attention on the parts of the
model that are changing during your animation.

You can define servo motors and specify a time in the animation when they
will be active.

Another feature that adds to the versatility of Design Animation is multiple-
body locking. You designate a lead body and one or more follower bodies, and
specify a time during the animation when the body lock is active.  During
that time in the animation, the follower bodies will follow the lead body in the
same relative position as when the lock took effect, as if they were glued
together.

You can define an animation for a subassembly, and the animation can be
used when the subassembly is included with the parent assembly.  This
makes it easy to define animations for small subsets of a large assembly, and
bring them together for a combined presentation.
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Accessing Design Animation
You access Design Animation from the Pro/ENGINEER Applications menu.
This allows you to:

•  work within the Pro/ENGINEER user interface
•  operate on the Pro/ENGINEER geometry model
•  use Pro/ENGINEER visualization, file manipulation, graphics, and

printing tools

Servo motors, snapshots, bodies, and connection definitions created in
Mechanism Design are inherited by Design Animation.

Note:  If you have not used Mechanism Design to build your assembly, you
cannot use the connection status or joint axis-based servo motor functionality
in Design Animation.

Learning Design Animation Basics
Before using Design Animation, you should become familiar with some
terminology and windows. Read the following topics to learn the basics of
working with Design Animation:

Topic Page

Terminology.......................................................................................................... 1-3

Design Animation Interface ................................................................................ 1-5

Terminology
The following list describes terms and their definitions or common uses:

 Item Definition

animation time domain the time period, number of intervals, or time step for the current
animation

body a combination of parts that move together as one unit, similar to
a body in Mechanism Design

connection a set of constraints that ties two bodies together and restricts the
relative motion of the bodies in some or all directions

connection status defines the state (Enable, Disable, Locked, Unlocked) of a
connection at a given time during an animation

display at time a specification that describes how every component in an
assembly is displayed at a given time (Blank, Wireframe,
Hidden Line, No Hidden, or Shaded)

event a named point in time.  It serves as a reference for other
animation components or events. You can create your own events
or use system-defined events.
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 Item Definition

geometric constraints constraints between geometric entities on two bodies applied
while using the dragging functionality

key frame sequence a set of snapshots that establish the location of certain bodies at
specific times

key frame sequence
instance

a copy of a key frame sequence included on the timeline

multi-body locking a temporary rigid attachment of follower bodies to a lead body
for a specified period of time

servo motor a component that specifies relative motion of two bodies on
geometric entities or about a Mechanism Design joint connection

servo motor instance a copy of a servo motor applied to the timeline for a specific time
period

snapshot a picture of the model with the bodies in a particular orientation
and position

subanimation an animation included as a component in the current animation.
It may originate with a subassembly of the parent assembly.  It
appears on the timeline as a line, without any of its components
shown.  To see the features of the subanimation, click on the
circle at the beginning or ending of the line.

system-defined events default events defined by the system for each component of the
animation.  These can include start and end times for each
component.

transparency at time a specification that describes the degree of transparency or
opacity for a selected assembly component at a given time during
an animation

view at time a view saved within Pro/ENGINEER (for example: FRONT) that
defines the orientation and magnification from which a model is
viewed at a given time during an animation
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Design Animation Interface
You can use Design Animation through Pro/ENGINEER menu commands, or
by clicking buttons on a toolbar, or by moving elements in the timeline.
Following are examples of the Design Animation toolbar and the timeline.

Toolbar   

The toolbar buttons represent Design Animation commands and act as a
quick way to get to the appropriate dialog box.  You can customize the toolbar
to include only those commands you use regularly.

Button Action/Name

Create a new animation

Control icon visibility

Define bodies

Drag model

Create key frame sequence

Create body-body locking

Start running the animation

Play back the animation

Export the animation to a frame file

Create a servo motor

Change the connection status

Create an event

Include a subanimation

Create a new transparency at time

Create a new view at time
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Button Action/Name

Define component display at time

Define the interpolation settings

Create a new transparency at time

Edit the selected entity in the timeline

Undo

Redo

Remove the selected entity from the animation
timeline

Zoom in on the time scale

Zoom out on the time scale

Zoom to refit the time scale

Change the animation time domain

Change the assembly tolerance

Timeline        
The Design Animation timeline is a graphical interface that appears below
the Pro/ENGINEER window when you start Design Animation.  The timeline
displays the items that make up your animation on a line drawing associated
to a time scale.  The components that make up the animation—including key
frame sequence instances, servo motor instances, and connection status—are
represented by triangles, diamonds, or circles connected by a line.

You add components to the timeline or edit existing components by using the
menu commands or the Design Animation toolbar buttons.  You can also
easily edit an existing animation by right-clicking on components in the
timeline.  A right-click brings up pop-up menus that let you edit, copy, or
remove the selected component from the timeline.  Clicking the middle mouse
button moves objects vertically, so you can view them more easily.



Introduction 1-7

The timeline is not only a convenient way to represent your animation; you
can also use it when you want to change your animation’s time parameters.
You can change the time when a specific event occurs by dragging the event’s
symbol to a different location on the timeline.  For example, you can change
the time when an animation or key frame sequence begins or ends by left-
clicking on the desired sequence and dragging the line connecting the
separate components to a new location with respect to the time scale.  You
can also position the key frame sequence for convenient viewing.

The following is an example of a Design Animation timeline:

body-body locking event

subanimation

connection status

key frame sequence instances

As the animation time progresses, the components in the timeline become
enabled at the appropriate time and move associated bodies to their desired
positions.  Multiple components may be enabled at any given time.

In addition to the components shown in the illustration, an animation can
contain information on enabling and disabling servo motors, information on
viewing the animation from different orientations, information on blanking or
unblanking your assembly components, and information on making your
assembly components transparent or opaque.
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Limitations
Following are the limitations associated with Design Animation:

•  Any definition (body, joint, servo motor) created in integrated Motion is
not available in Design Animation.  It is available if created in
Mechanism Design.

•  You cannot transfer data from Design Animation to Motion, but you can
use snapshots and servo motors in Mechanism Design.

•  Pro/ENGINEER constraints are not honored in Design Animation, but
they are used in the initial body definition.

•  If you export your animation to a frame file (extension .fra), it does not
save the view orientation.

•  Constraints and locked bodies (to ground) are saved with a snapshot.
However, they are not enforced during a key frame sequence animation.
You may need to define body locks and connections within Design
Animation to get the desired animation.

•  View interpolation settings must be set for the entire animation. These
settings are not honored in subanimations.

•  Opening a simplified rep may cause animation components to be deleted.
If you then save the animation and open the master rep, you may lose
information.  To retain the master rep animation, do not save the
simplified rep.  This is also true for suppressed components.
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2 
Creating an Animation

Using the Design Animation timeline and toolbar, you can create an
animation for your assembly.  Read the following topics for an introduction to
the components of an animation.

Topic Page

Overview ............................................................................................................... 2-2

Using Bodies ......................................................................................................... 2-4

Taking Snapshots................................................................................................. 2-4

Defining a Key Frame Sequence ......................................................................... 2-5

Working with Servo Motors................................................................................. 2-6

Body Locking ........................................................................................................ 2-7

Working with an Event........................................................................................ 2-7

Connection Status ................................................................................................ 2-8

Working with the Animation Appearance.......................................................... 2-8

Design Animation Tips ........................................................................................ 2-8
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Overview      
You can create an animation to do many different things.  Depending on your
objective, you may use different steps to create your animation.

Following are the typical steps you might take to create an animation:

1. Open an assembly in Pro/ENGINEER and start Design Animation.

2. Create a new animation and give it a meaningful name using the
Rename command.

3. Check your body definitions:

■  For a Pro/ENGINEER assembly, you probably want to select One
Part per Body and then edit the body to put the parts into the
appropriate moving groups.

One Part per Body will empty the ground body of parts. You should
edit the body named ground and reassign ground parts to it.

■  For a Mechanism Design assembly, you should check that the body
definitions are as desired.

4. Define animation components that create movement.

■  To specify general movement, create key frame sequences.  To create
key frame sequences, take snapshots of your assembly at specific
positions, using the drag functionality to move bodies to new
positions. Design Animation will interpolate between these key
frames to produce a smooth animation.

■  To create specific movement between bodies connected by joints or
between geometric entities, define servo motors on joints or geometric
entities.

5. If not already on the timeline, include the servo motors and key frame
sequences on the timeline. Any components included on the timeline form
the basis for your animation.  You can edit the timeline length and
increments, as well as the length of the servo motor or key frame
sequence in the animation.

6. Optional: If you have not already included body locking, events, or
connection status in the timeline, you can add them now.

■  If you want a group of bodies to be fixed relative to each other for a
part of the animation, you may want to set up body locking for that
time period.

■  Changing the connection status is useful for assembling and
disassembling your model.  If you are working with key frame
sequences, you have probably changed the connection status while
dragging bodies to position them in snapshots.  If you are working
with servo motors, you want to use the Animation > Connection

Status command, or click   on the toolbar.
■  If you need to have animation components sequenced in a particular

order, you can specify a system-defined or user-defined event as a
reference, or you can group them together in a subanimation.

7. Run your animation.
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8. If you have problems, try one of the following:

■  Make sure your mechanism is not overconstrained.  For example,
check that a servo motor and key frame sequence do not require
conflicting positions.

■  Increase the number of time steps (Tools > Time Domain or click

).
■  Try changing the tolerance (Tools > Animation Settings or click

).
9. Use the Playback dialog box to rerun the animation.  If desired, check

for interference and other results.

10. Define views along your animation to view the orientation and
magnification of your model. Also, choose an interpolation method for
your views.

11. Specify component displays along the animation for your assembly
components.

12. Rerun the animation and view results.

13. Save your animation and results.  You save your results using the Save
button on the Playbacks dialog box.  Design Animation saves your
playback results to a .pba file.  To save the animation to disk, you must
save the entire assembly using File > Save.  Design Animation saves
your animation to the .asm file with your model. You can also export to a
.fra file, or you can save the animation as a graphic file.

See the following sections for more information about bodies, snapshots, key
frame sequences, servo motors, events, connection status, and body locking.
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Using Bodies
A body is a group of parts that move as a unit.  There is no relative motion of
parts within the group.  You can define a group of parts as a body in Design
Animation, or you can add components to a body that was defined in
Mechanism Design.

Body definition is important because you can define movement and create
body locking only between distinct bodies.

Following are the rules for body definitions:

1. By default, bodies in Design Animation are created using the Mechanism
Design body rule.  The Mechanism Design body rule is that parts with a
Pro/ENGINEER constraint (not a connection constraint) are placed in a
single body.

2. Once you modify a body definition in Design Animation, the modified
body definition holds.  Any new parts subsequently added to the assembly
are placed in bodies following the Mechanism Design body rule.  One
Part per Body is considered a body modification operation.

3. Bodies defined in a subassembly cannot be modified in the parent
assembly.  For example, you cannot add or delete a part to a body
redefined in a subassembly.

Note:  Neither the One Part per Body nor the Default Bodies
operations on the Bodies dialog box will override the body definitions
contained in a subassembly.

When you add parts to a body, they are deleted from any other bodies that
previously contained them.  If you delete a body, all of its parts are moved
into the Ground body.

Editing body definitions may cause connections, servo motors, and other
animation components to become invalid.  Invalid components are
permanently deleted from the animation timeline.

Note:  Any change you make to a body definition in Design Animation will
only be valid while you are in Design Animation.  You cannot transfer the
body definition to Mechanism Design.

Taking Snapshots    
You use dragging to place bodies in their desired position for a snapshot.  You
can drag a point or body.  You can choose free-form movement, or movement
along a coordinate system axis.  Design Animation attempts to position the
selected entity as close as possible to the current cursor location.  The Drag
dialog box displays the coordinates of the drag point with respect to a selected
coordinate system and updates the coordinates as you move the model.  You
can use this display to place your component more precisely, or to recall a
previous position.  When the desired orientation is reached, you click the
snapshot button to capture the current position and orientation of each body
in the model.
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You can choose to have connections between bodies remain connected during
the dragging process, or you can disable the connection.  You can also apply
two types of temporary geometric constraints to the model—Align and Mate.
The constraints are in effect only during the dragging operation.  You can
select points, lines, or planes on the model for alignment.  When you align
two planes or surfaces, they become coplanar and face the same direction.
When you align lines they become coaxial.  You can mate only planar
surfaces.  When you mate planes, they face each other.  You can also orient
two planes to be parallel, and specify the distance separating them.

You can constrain the relative position of the bodies connected by a joint by
entering a value for the joint axis position.

You can specify that one or more bodies remain stationary relative to ground
during a dragging operation by locking them.  You can also lock or disable a
connection, so it does not move or is ignored, respectively.  Design Animation
saves the body locking and connection status information with the snapshot,
so if you edit a snapshot those features will be active.

If you are creating a new key frame sequence or editing an existing key frame
sequence, the snapshots you take are automatically added to the key frame
sequence.  However, if you click the button on the Design Animation toolbar
to create snapshots with the Drag dialog box, Design Animation will not
automatically add the snapshots to any key frame sequence instance in the
animation.

Defining a Key Frame Sequence
A key frame sequence is a series of snapshots that show the change in
position and orientation of parts or assemblies over a period of time.  You
define the body locations relative to ground or to another body.  You decide
whether each body’s position is required, desired, or unspecified.  Design
Animation will interpolate between these key frames to produce a smooth
animation.

A key frame sequence definition includes the following items:

•  name
•  bodies controlled by the sequence
•  ground or other reference body
•  time of each key frame (snapshot)

•  locations of the bodies
You make a key frame by moving the model into the desired orientation and
taking a snapshot.  After a group of snapshots is prepared, you place them in
the desired order in the key frame sequence.  After you prepare and save
snapshots, you can reorder them in later key frame sequences.
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While creating or editing a key frame sequence, you can preview existing
snapshots, change the order of the snapshots, make new snapshots, and add
snapshots to the key frame sequence.   When you include the key frame
sequence as an instance in an animation, it appears in the timeline window.
Each key frame is represented by a triangle, and a line connects the
triangles.  You can drag a triangle on the timeline to a different time and the
associated key frame will update automatically.

When creating the sequence, you control the importance of each body’s
location by specifying whether its status is Required, Desired, or
Unspecified.  Any body that has its status set to Unspecified is not
controlled by the sequence.  You also select a reference body, which can be
ground, for the entire sequence.  All bodies whose status is required or
desired in that sequence will be placed in the appropriate position, as defined
by the snapshot, relative to the reference body at each time in the sequence.

If the reference body moves, all of the controlled bodies in the sequence will
then move with it.

When you run your animation, if the bodies do not move to the correct
position, especially at key frames, you should try using the Required status.
In general, however, you should use Desired, because Required may over-
constrain your assembly.

The entire key frame sequence can be reversed.  This is useful, for example,
in illustrating the assembly of a mechanism.  If you remove the parts of your
assembly one by one in a key frame sequence, reversing that key frame
sequence produces an animation illustrating the assembly of the model.

Working with Servo Motors
You use servo motors to impose a particular motion on your mechanism
without regard to what forces are required to cause the motion.  Servo motors
force a specific type of motion to occur between two bodies.  You can place
servo motors on joint axes or between geometric entities such as points and
planes on different bodies.

Design Animation offers several types of servo motors.  When you define a
servo motor, you first specify how you want the motion to change with respect
to time—either by position, velocity, or acceleration—and whether you want
the motion to be translational or rotational.   Within these broad categories,
Design Animation provides several profiles you can use, including ramp,
parabolic, and polynomial.  In addition, you can define your own servo motor
function, either with a table, or with a mathematical expression.  You can
define, edit, or copy servo motors in both Design Animation and Mechanism
Design, and the servo motor definition will be valid in both applications.

Once you define your servo motor, you can include an instance of the servo
motor for a specified length of time.  You can include the servo motor
multiple times in the animation and specify that each servo motor instance is
applied at a different time during the animation.  For each instance, the
servo motor function will be evaluated using relative time from the start of
the instance.
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Body Locking
You can use the multi-body locking functionality to lock bodies to a lead body.
Design Animation determines the relative position and orientation of the
follower bodies with regard to the lead body at the time the body locking
becomes active in the animation and keeps them in this same orientation
while the lead body moves according to the animation’s definition.  When
body locking ends in the animation, the bodies are allowed to move
independently again.

Working with an Event      
Events are used to synchronize animation components relative to one
another.  The beginning of the animation is a default event named "start."  As
you include components in an animation, you can set them to start or stop at
some time relative to the beginning or end of other components.  This means
that you can associate components so that their relationship in time is
maintained through subsequent changes.  You can rearrange the order of
your components to draw attention to the most important part.

For example, you can define an animation that includes several components.
In the following figure, the animation includes two key frame sequences,
Kfs3.2 starting at time 0 and Kfs1.4 at time 2 seconds.  In addition, there are
two connection status events.  A joint is disabled at time 1 second (noted by a
hollow circle) and enabled at time 2 second (noted by a filled-in circle).  All
four of these components are defined with respect to Event2, which in turn is
defined as beginning at the start of the animation.

Suppose you decide to insert a third key frame sequence, Kfs2.6, in front of
this sequence of events.  Define the Start time for Kfs2.6 as the start of the
animation, then change the start time for Event2 to 2 seconds after Start.
The other events that are linked to Event2 are automatically shifted ahead in
time without changing their relationship to each other.
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Connection Status
You can change the status of a connection during an animation.  Using this
functionality, you can disable a connection so a servo motor can move a body,
then enable the connection so the body moves with its connected body.
Changing the connection status is useful when assembling and disassembling
a mechanism during an animation.

Working with the Animation Appearance
After you are satisfied with the way your assembly moves during the
animation, you can adjust the appearance to emphasize certain portions of
the animation.

•  You can move smoothly from one orientation of your model to another
during the animation by using the view-at-time functionality.  For
example, you might want to begin the animation by viewing the assembly
from the top, and then zoom in on a portion that is moving.

•  You can define different display states, in which you make the less
important parts of the assembly invisible, with the parts that you want to
emphasize shaded.

•  You can use the transparency-at-time functionality to make one of the
assembly’s components completely opaque at one point during the
animation, then smoothly make its surfaces transparent, so that the
components hidden beneath it gradually become visible.

Design Animation Tips
Following is some helpful information you should know when using Design
Animation:

•  By default, a key frame sequence controls locations of all of the bodies
during an animation.  If you want the bodies to be able to move more
freely—for example, if a servo motor needs to move them—you should
specify that the body definition is Unspecified instead of Desired when
defining a key frame sequence.

•  When creating constraints during drag, multiple planar constraints can
easily lock up an assembly if the constraints close a loop.  It is very
difficult to keep plane normals aligned.  Try to avoid closing loops or
using other constraint types.

•  When adding a constraint to a long chain of connected bodies, try to add
the constraints to bodies that are "near" each other.
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•  Dynamic spinning works best when you use the screen center option on
the Orientation dialog box. You can access this dialog box using
Pro/ENGINEER’s View > Orientation > Reorient command. Select
Dynamic orient in the Type pull-down menu. When this is done, try to
get the spin center icon to be over a physical part.  This makes dynamic
spinning behave much better.

•  Key frame sequences have a lot of freedom to move parts around.  When
parts move unexpectedly, try tying things down using body locking and
constraints.

•  If you are using an assembly created in Mechanism Design, you should
use Lock Bodies to regroup parts into groups if you are animating after
an assembly sequence.
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